FBDI UPLOADS -

QuIick REFERENCE GUIDE GL-24

Purpose

The purpose of this Quick Reference Guide (QRG) is to provide a step-by-step explanation of how to
perform File Based Date Import (FBDI) Uploads in the North Carolina Financial System (NCFS).

Introduction and Overview

This QRG covers the process of performing FBDI uploads in NCFS.
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[ The following are prerequisites to upload using FBDI: I
[

I 1. Download the Journals Import Interface FBDI from Oracle Docs.

FBDI Uploads

To upload journal entries via FBDI, please follow the steps below:

1. Prepare the data for each interface table. To prepare the data, set up data merge and
search internal identifiers. Refer to the colored indicator on the top right corner of each
column header to:

e \View detailed instructions on preparing the data in that column.
e View a description of the data and data type that the column requires.
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2. Once the data is prepared, click the Instructions and CSV Generation sheet tab, and then
click the Generate the CSV File button to generate a ZIP file that contains one or more CSV

file.

Note: To download the Oracle FBDI template and view a sample/example file, click the OSC
webpage link - https://www.osc.nc.gov/state-agency-resources/north-carolina-financial-

system-ncfs-resources

Generate CSV File

Excel Template Format
» Each interface table is represented as a separate Excel sheet.

- Date fields must be entered in YYYY/MM/DD format

Recommendations for Loading Journal data

interfaces and the strategies for populating them.
| Instructions and CSV Generation | GL_INTERFACE @

- Amount columns must not contain a thousands separator and must use a period (.) as the decimal separator.
- Columns that must be whole numbers have data validation to allow only whole numbers
* Columns have been formatted, where applicable, to match the expected data type to eliminate data entry errors.
» For columns that require internal ID values, refer to the bubble text for additional guidance about finding these values,

* The first row in each sheet contains column headers that represent the interface table columns. The columns are in the order that the control file expects them te be in the data file.
Do not change the order of the columns in the Excel sheets. Changing the order of the columns will cause the load process to fail.
You can hide columns that you do not intend to use, but you cannot delete columns. Deleting columns will cause the load process to fail.

» Each column header contains bubble text about the expected data type and, in some cases, instruction text.

» You must enter data that conforms to what the control file can accept and process for the associated database column.

Because the details of any data conversion will vary, the scope of this document is limited to a best practices approach. If you are new to data conversion, we recommend consulting Oracle resources on open

=

3. The Save As pop-up appears. Enter the file name in the File Name field. In this example,
choose GLInterface. From the Save as type drop-down choice list, select CSV Files (*.csv).

Click the Save button.

EWl Save As X
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4. The Please select a location for ZIP file pop-up appears. Select the required Folder Name.

you want to download the zip file into. In this example, choose Downloads. Click the OK
button.

&« v & > ThisPC » Downloads v [$] L Search Downloads

Organize ~ New folder = - (2]
!’ Microsoft Excel No items match your search.

% This PC

- 3D Objects
[0 Desktop
|:: Documents
4 Downloads
J5 Music

&= Pictures
i Videos
25 0SDisk (C)

& Network v

Folder name: | Downloads

Tools ¥ | oK | Cancel

5. The downloaded zip file can be viewed in the Downloads folder of the local device.

“ v 5 | I |
Home Share View
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Earlier this week (1)

Last week (12)
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6. Log into the NCFS portal with your credentials to access the system.

7. Onthe Home page, click the Tools tab and select the File Import and Export app.

¢ Cash Management

Fixed Assets Expenses

Procurement

My Enterprise

Tools >

QUICK ACTIONS

Manage Collaboration Messaging

History

Al Apps Administration

APPS

Set Preferences

Export
Management

Reports and
Analytics

Scheduled
Processes

File Import and
Export

Transaction
Console

8. Under the Search Results section, click the Upload [ 4] icon.

Overview @
» Search

4 Search Results

Actions w View w x

File Account

Owner

Upload Date Process ID

Mo search conducted.

9. The Upload File pop-up appears. Click the Choose File button to attach and select the zip
file, the macro generated. On the Account field, select fin/generalLedger/import from the

drop-down choice list. Then, click the Save and Close button.

Upload File

* File | Choose File JNo file chosen

T Acl:ountl finigeneralLedgerimport

VI

] o
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10. Click the Home [[& ] icon.

Overview @

b Search

b Search Results

11. On the Home page, click the Tools tab and select the Scheduled Processes app.

APPS

QUICK ACTIONS

nage Collaboration Messaging

Al Apps Administration

12. On the Overview page, click the Schedule New Process button.

Overview @
» Search Saved Search  Last hour v
Search Results (3)
View (@) Flat List Hierarchy
Actions w View w Schedule New Process 1 9]
Name Process ID Status Scheduled Time Submission Time
Rebuild Learning Item Stop Word Index 2189002 Wait 5/23/23 10:30 AMEDT  5/23/23 10:25 AM EDT
Rebuild Learning Item Stop Word Index 2189001 Succeeded 5/23/2310:25 AMEDT  5/23/23 10:25 AM EDT
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13. The Schedule New Process pop-up appears. On the Name field, select Load Interface File
for Import from the drop-down choice list. Then, click the OK button.

Schedule New Process

Type (@) Job () Job Set

Name I Load Interface File for Import

Description Transfers setup or transaction data files from a user-specified location to the interface tables

14. The Process Details pop-up appears. On the Import Process field, select Import Journals
from the drop-down choice list.

Process Details x

@ This process will be queued up for submission at position 1

Process Options | ‘ Advanced ‘ ‘ Submit ‘ | Cancel |

Name Load Interface File for Import

Description Transfers setup or transaction data files from ... D Notify me when this process ends

Schedule As soon as possible Submission Notes I

Basic Options

Parameters

* Import Process I Import Journals v I

* Data File ‘ v

15. Select the imported file from the Data File drop-down choice list.

Note: The file can only be selected if steps 4-6 are followed, and the file is uploaded into
the system.

Process Details

Q This process will be queued up for submission at position 1

Process Options | | Advanced ‘ ‘ Submit‘ | Cancel |

Name Load Interface File for Import

Description Transfers

dhi .Zip  finS/generalledger$/import$ wdhier... 2021-04-02 09:27:59 AM
Schedule As soon

JournallmportTemplate.xism fin$/generalLedger$/import$ JournallmportTemplate....  2023-06-12 09:40:25 AM

Basic Option

Parameters

Gljournals.zip I fin$/generalLedger$/import$ Gljournals.zip 2022-01-31 05:40:08 AM

AccountCombinationsimpertTe...  finS/generalLedgerS/import$ AccountCombinationsim... 2023-02-02 09:08:01 AM

* Import Process MAGTE

Upload a new file

* Data File v

1/26/24 NORTH CAROLINA OFFICE OF THE STATE CONTROLLER PAGE 6 OF 11




QRG GL-24 - FBDI Uploads

16. To open a file that wasn’t uploaded into the system, click the Data File drop-down choice
list and select the Upload a new file link to upload the created zip file from the local
device.

Process Details x

@ This process will be queued up for submission at position 1

AccountCombinationsimportTe...  fin$/generalLedger$/import$ AccountCombinationsim... 2023-02-02 09:08:01 AM

Gljournals.zip fin$/generalLedger$/import$ Gljournals.zip 2022-09-30 05:31:47 AM
Name Load Inte
Gliournals.zip fin$/generalLedger$/import$ Gljournals.zip 2022-09-30 05:02:38 AM
Description Transfer:
Gliournals.zip fin$/generallLedger$/import$ Gljournals.zip 2022-02-23 05:43:36 AM
Schedule As soon

Gljournals.zip fin$/generalLedger$/import$ Gljournals.zip 2022-02-23 05:02:06 AM
Basic Options gjoumais zip fin$/generalLedger$/import$ Gliournals zip 2022-01-31 05:40:00 AM
Parameters

glsegmentvaluesandhierarchy.zip ~fin$/generalLedger$/import$ glsegmentvaluesandhier... 2021-04-02 09:27:59 AM

More...

IUp\nad a new file I
* Data File [ v

* Import Process,

17. Click the Choose File button.

Upload File

Choose File i No file chosen

18. Select the zip file from your local device and click the Open button.

A =
\
\
Gllnterface.iip
v
[e name: | Glinterface.zip V‘ Al files (*.*) V|
I Open I | Cancel ‘
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19. Click the OK button.

Upload File
Glinterface.zip

20. Click the Submit button.

Process Details x
(@ This process will be queued up for submission at position 1

Process Options | Advanced | m | Cancel ‘

Name Load Interface File for Import

Description Transfers setup or transaction data files from ... [_\ Notify me when this process ends
Schedule As soon as possible Submission Notes
Basic Options
Parameters
* Import Process ‘ Import Journals v
* Data File | Glnterface zip v

21. A Confirmation pop-up appears. Click the OK button.

[E Confirmation

Process 2227385 was submitted.
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22. On the Overview page, ensure that the process is completed successfully by verifying that
the Status says Succeeded.

Search Results ()
View (@) FlatList () Hierarchy
Actions v View w Schedule New Process | Resubmit PutOnHold Cancel Process Release Process Viewlog 1)
Name Process ID Status Scheduled Time Submission Time
I Load Interface File for Import 2227385 Succeeded I 6/12/23 9:47 AMEDT  6/12/23 9:47 AMEDT

23. On the Overview page, click the Schedule New Process button.

Qverview @

b Search Saved Search | Last hour v

Search Results (2)

View (@) Flat List Hierarchy
Actions v View w Resubmit PutOnHold Cancel Process Release Process Viewlog 40
Name Process ID Status Scheduled Time Submission Time
Rebuild Learning Item Stop Word Index 2189002 Wait 5/23/23 10:30 AMEDT  5/23/23 10:25AM EDT &
Rebuild Learning Item Stop Word Index 2189001 Succeeded 5/23/23 10:25 AMEDT  5/23/23 10:25 AM EDT
Rebuild Learning Item Stop Word Index 2189000 Succeeded 5/23/23 10:25 AMEDT  5/23/23 10:25 AM EDT
Ingesting attachments to OSCS 2188999 Wait 5/23/23 10:32 AMEDT  5/23/23 10:22 AM EDT

24. The Schedule New Process pop-up appears. On the Name field, select Import Journals from
the drop-down choice list. Then, click the OK button.

Schedule New Process

Type (@) Job () Job Set

Name Ilmport Journals

Description Transfers setup or transaction data files from a user-specified location to the interface tables.
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25. The Process Details pop-up appears. Enter the values in the parameters mentioned. In this
example, choose:
Data Access Set: NC CASH- AGENCY 2A00
*Source: Agency Journal Interface
*Ledger: NC CASH US
Group ID: No Group ID
Post Account Errors to Suspense: No
Create Summary Journals: No
Import Descriptive Flexfields: No

@ This process will be queued up for submission at position 1

Process Options | Mmd‘ Suhmn.‘ ‘ Q-mzl‘

Name Import Journals
Description Creates journal entries from imported informati | Notify me when this process ends
Schedule As soon as possible Submission Notes

Basic Options
Parameters

Data Access Set | NC CASH - AGENCY 2A00 v

* Source | Agency Journal Interface v

* Ledger | NG CASHUS v

Group ID | No Group ID ~

Post Account Errors to Suspense  No ~

Create Summary Journals No v

Import Descriptive Flexfields | No ~

26. Click the Submit button.

0 This process will be queued up for submission at position 1
Process Options. | Adﬂnud} Isﬂ:mlll‘ Cancel
|

Name Import Journals
Description Creates journal entries from imported informati Notify me when this process ends

Schedule As soon as possible Submission Notes

Basic Options
Parameters

Data Access Set | NC CASH - AGENCY 2A00 ~

* Source Agency Journal Interface -

* Ledger | NC CASHUS ~

Group ID | No Group ID v

Post Account Errors to Suspense | No ~

Create Summary Journals | No  ~

Import Descriptive Flexfields | No ~
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27. The imported journal’s details can be viewed here by clicking the schedule process Import
Journals: Child.

Qverview @

» Search Saved Search | Last hour ~
Search Results (2)
View (@) Flat List ) Hierarchy

Actions v View w Schedule New Process | Resubmit PutOnHold Cancel Process Release Process Viewlog 4)

Name Process ID Status Scheduled Time Submission Time
I Import Journals: Child 2221397 Succeeded 6/9/23 5:18 AM EDT 6/9/23 5:18 AM EDT I
Import Journals 2221396 Succeeded 6/9/23 5:18 AM EDT 6/9/23 5:18 AM EDT

28. Under the Process Details tab, click the 1 more... link to view all the attachments.

Process Details  Status Details

Import Journals: Child, 2221397
Status  Succeeded Schedule Start  6/9/23 5:18 AM EDT ParentID 2221396
Log and Output
Attachment ESS_L_222139
b Parameters

29. Click the .txt link to view further details about the imported journal.

Attachments

Actions v View w

Type Category * File Name or URL Title Description Attached By

Enterprise Sct v ‘ 2221397 log ‘ ESS_L_2221397 ‘ ESS Job Request Process ‘ Training Supe

Enterprise Scr | [2221397.0] | EsS_0 2221307 | £S5 Job Request Process | Training Supe

< »

Rows Selected 1

Wrap-Up

Users can Import Journals to load feeder system journal entries and upload the journals via FBDI by
following the steps above.

Additional Resources

Virtual Instructor-Led Training (vILT)

e GL103 Journal FBDI Uploads
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